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! While Cathexis has made every effort to ensure the accuracy of this document, there is no guarantee of accuracy,
neither explicit, nor implied. Specifications are subject to change without notice.
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1 Introduction

This guide will detail the different operating procedures that the person in the control room may be expected
to undertake, using the CathexisVision Base-station Client. This does not include the setup’s that take place,
either in the setup tab, or via the menus. For this information please refer to the Setup Manual.

For example this manual will deal with questions such as “how do | zoom in a PTZ camera”, and “how do |

review previously recorded footage?” The Setup Manual, on the other hand, will provide information on how
one would add and setup a new camera, or add a motion detection algorithm to a camera.

Opening a Connection to a Site

The CathexisVision Client is not tied to any particular site, and as such, the user first has to open a connection
to the site they wish to view.

Clicking on File => Open Site will open a list
of all sites that have been added to the
Viewing PC. Select the site you wish to view.

Video wall Tools Settings Help

ﬁ Open site r
@. Enterprise manager

catcenturicnsecurity
Cathexis Africa Centuricon

Security system
Virtual NVR

=  Archive viewer

Virtual NVR »

After selecting your site, you should be prompted to enter in your
login credentials.

4R
Login to Cathexis Africa Centurion

ELCNIEEUE  BCLIEREE LERGE  |f the default is to log in at a

Mame |

Fa Opentab » certain level, and you wish to
Password & Close site's tabs login with your specific user
7 Changelogin... click on Site —> Change login

[ ok ] [ Cancel ] and enter your credentials.
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2 Cameras Tab

This section will deal with the Cameras Tab, which is the tab through which the operator will view live footage,
as well as review recorded footage.

Open the Cameras Tab

After opening a connection to the desired site, as described above the operator must open the Camera Tab.
There are three ways to do this:

Option 1

Edit View Site Videowall Tools Settings Click on File —>

Your_Site —> Open

File

=

@, Enterprise manager

O it
pen site tab —> Cameras Tab

= Archive viewer

74 Virtual NVR b |F3  Opentab v [& Cameras
Option 2
Site Videowall Tools Settings Click on Site —> Open tab —> Cameras
E?: Open tab [E Cameras
Option 3
| == virtual NvR — 2 ' This option will only a tab for site

o Opentab » |[E Cameras open in this tab. Right click on the

figy Close site's tabs = Databases site’s open tab and click Open
— tab—> Cameras

=1 —
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a. Main Screen Areas

The following presents a brief introduction to the various features of the Cameras Tab, which will each be
dealt with in deeper detail, further on in the document.

File Edit View Site Videowall Tools Settings Help o em @
& viriainve B E% Virtual NVR

l@ Resources (7)) -

= @ Factory
[ @HighwayI 1
@ Highway 2
@HighwayI 3
@Shop Queue
Q Waiting Room

|I_IIII_||![,|

B .=3175033554

J<lol*I*|EEE

-

1z
a4

xi i

& dvs (Administrator) @ CathexisVision Premium  Supplied to Documentation by Cathexislntemf‘;\ @ E &
2/

@ The menu bar provides menu options for the current desktop, and shows your access rights. These menu
options change on a tab-by-tab basis.

@ These are the various tabs (camera, database, and setup) for one or multiple sites.
& virualtvr B3 = virual R[] |

The colour of the text in the tav indicates its connection status:

(& TestNVR Red: Online
Black: Offline

[E] TestNVR Blue: Connecting
& TestNVR Green: Online But not
Current

Each Site can be custom-configured to automatically load certain tabs, when a connection is made to the Site
(this is configured from File —>Enterprise Manager —> Right Click Site —> Properties). To close a tab click on 8.

@ The cameras panel contains the individual panels on in which cameras are viewed. Selected cameras are
outlined in red; unselected cameras have no outline.
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@ The timeline will show the current time of the selected panel/s. The white area indicates time that has
passed; the grey area indicates time approaching; the point between them indicates the present time.

@ The review controls panel hold the tools used in reviewing, and archiving, recorded footage, for one or
multiple cameras.

@ The resource panels mouse over options include a number of options:
Lock display. Some CathexisVision events will be setup to switch the camera panel to view cameras

]

related to the event. Clicking on this lock will enable/disable this feature. An unlocked display (fi'\"l) will
switch; a locked display won't.

PTZ Controls. This will pull up a basic PTZ control menu. For a, potentially, more detailed menu see
the note on Number 7 (below).

Event Notifications.

Configure Resource Panel.

Resource Panel Filter.

o EEx] o

[E Resources v” The panel selector is a dropdown bar for selecting from a
variety of panels:

@ PTZ o PTZ

& Contacts e Resources.

o

e Contacts.

m The Local Resources bar (top right) shows the status of local hardware resources:

@ Local default audio input (e.g. your microphone)

@ Local default audio output (e.g. your speakers)

Local monitor

When active, these resources display _, and when inactive they are grey. If you run your cursor over
an active resource, a “tooltip” will provide information on the activity. For example, mouse-over a green
monitor to see what camera is displaying to that monitor. If you have many local resources, they will be
arranged in a scrolling area, with left and right scroll arrows.

@ The status bar, at the bottom on the interface provides relevant information:

AL dvs (Administrator) The username, and their access level.
(&) CathexisVision Premium The license.

Supplied to Documentation by Cathexis Internal | The distributor of the license.

] Licensing status. If there are any expired, or missing licenses
this will change colour.

] The performance monitor.

Note: There is a detailed description of how this works in the
setup manual.

Draft Rev 1.2 November 25, 2014 Page 6




Connection status.

b. Cameras Panel Overlays and Context Menu

This section will cover the different overlays that are visible on each panel, and the options available in the

context menu.

Overlays

Live

Review
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Green text shows that the stream you are
viewing is live.

The text in the top left (Highway 1 here) is
the camera’s given name.

The timestamp is seen on the bottom
right.

Al present in the top right hand corner
of the panel indicated that the camera is
currently recording to one of the
databases.

Red text indicates that the video in this
panel is being reviewed, from previously
recorded footage.

The text in the top left (Highway 1 here) is
the camera’s given name.

The date, and, timestamp is seen on the
bottom right.
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Mouseover Overlay
When you hover the mouse over a camera’s panel you will see the little black- arrow icon appear on the left-
middle of the panel. Clicking on this icon will expand the menu, as you see below:

Click on . to allow you to change which
algorithm information is overlaid (if there
are algorithms set up).

{1

Clicking on will allow you to select
between available video feeds for the
selected camera. (This is very useful when
you need to view a camera over a slower
link, and the camera provides a lower
format/resolution video feed.)

Note: When you are reviewing video you will also see the database icon Ein the list. This will allow you to
select which database you want to review video from. This is useful if this camera records to multiple

databases.

Review Button Overlay
Under Settings —> Video Display there is an option called ¥/ Show review button overlay

General... When checked you will see the following overlay when you m
Video display mouse-over a camera panel where the video is currently being
=23

reviewed:

Context Menu

To see the context menu, middle-click the mouse on the camera panel of your choice.
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Start recording

Video format
View transform
Owerlays

Help
Switch to review

Copy snapshot to clipboard
Print snapshot...

Save snapshot...

Enlarge panel
Maximise panel
Shrink panel

Resize panel
False colour
Clear panel

Cameras fullscreen

Select, or Move, Cameras

N

Start recording. If User Recording has been setup, this option will allow
the user to manually trigger a recording. (An & icon will appear in the
top right hand corner, when a User Recording is in progress.)

Video format will allow the user to select which of the cameras video
streams (which format/resolution) they wish to view.

View transform allows you to transform images for cameras with
special lenses. (E.g. 360 degree cameras.)

Overlays will allow you to view the different analytics algorithms that
have been applied to this camera’s feed, live in the Cameras Tab.

Help will pop-up a help window on Digital Zoom, and PTZ Control
within this panel.

Switch to review/live will allow you to switch back and forth between
live and review footage.

Copy snapshot to clipboard will allow you to copy the current still-
image from a camera to your clipboard.

Print snapshot will print the snapshot that is currently on the
clipboard.

Save snapshot will allow you to save the snapshot to disk.

Enlarge panel will enlarge the camera panel.

Maximise panel will enlarge the panel to fill the tab.

Shrink panel will reduce the size of the camera panel.

Resize panel gives you more resizing options.

False colour will change the colour of the image to false colour.

Clear panel removes the camera/s from the currently selected panel/s.
Cameras fullscreen will fill the entire screen with the Cameras Panel;
creating a Video Wall. Pressing ESC, on the keyboard, will exit.

To select a single camera left-click on it.
To select multiple cameras, hold down CTRL while left-clicking on the cameras you wish to select
To move a camera, from one panel to another, right-click-and-hold the camera and drag it to the new

panel.

CTRL-A will select all cameras in the Cameras Tab.

Digital Zoom

You can zoom in digitally on cameras that have no physical PTZ capability. This is done by selecting the specific
camera in the Cameras Panel and doing the following:

Zoom in/out

Scroll the mouse wheel.

Zoom to area

While holding the shift key, drag-select an area using the left mouse button

Pan

Pan the image using the left mouse-button. This is done by holding down the left mouse button, while moving
the mouse.
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c. Review Controls (Timeline and Review Controls Panel)

This section will deal with reviewing video in CathexisVision 2015. There are two sections that may be used to
review recorded footage. The Review Control Panel, and the Timeline.

Review Control Panel

Go to first recorded frame

— Review/Live
— Play backwards
— Step backwards

— Pause
— Step forwards

— Play forwards

FDate/Time wheel

soav 19707754+

|. l [ | | l | } |_l |_l ;_-) 10s — Loop period selector

¥l - ‘ — Playspeed

Archive Enable/Disable loop of Start and End tags
selection time period

Note: When you click the Dicon, to enable review, it will change to an [_‘ icon. Clicking the running-man
icon will return you to live view.

e To Review Footage from a Certain Date

Using the Time/Date Wheel

Man & 14 A 20 A 18 A To go to a specific date, select the camera/s that you wish to review, and
270a¥ v v ¥ click on the arrows of the Date/Time wheel until you have settled on the
correct date/time.

Using the Timeline

To move to a date and time, using the timeline simply left-click and hold anywhere on the timeline, and drag
the timeline to the time/date you desire.

e Selecting a Period for Review

After finding something of interest, you may wish to loop through the recorded footage around that event.
(This can also be useful when selecting footage for archive).
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Start by using the using the Date/Time wheel, to navigate to the desired beginning point. Once you have it,
click on the D icon, which will tag the start of your selection. Then navigate to the end of your desired period,
and click on the D icon, to tag the end of your selection.

T I .= The selected areas will appear as you see to the left. By default it will be set to loop.

— This can be seen when looking at the loop icon

'~ | means that it will loop, to the beginning of the selection, as it gets to the end of the selection.

D Means that the video will continue to play past the end of the selection.

Timeline

The timeline at the bottom of the GUI indicates where in time the currently selected cameras are.
Note: while you may review legacy video in CathexisVision 2015 (recordings made on pre 2015 systems) the
timeline will remain blank.

e Live View Timeline

Thu, 23 Oat | The live view
20|00 2015 2030 2 L .

timeline simply

show the current

time at the

intersection
between white and

grey.

e Single, and Multiple, Camera Review Timeline

20|00 20(15 20|30 2045 21|00 21[15 21(30

Highwany 1 T camera’s recorded
video you will see

the timeline change
to show red blocks.
These blocks on the
timeline represent
recorded events.

Th, 23 Ot @ When reviewing a

20/ 00 2015 20|30 20 45 210D 21|15 2130 K
Highway 1 —— multiple cameras to
Spar Overview ] review they will

appear stacked on
the timeline.

Thu, 73 Oct W If you have selected

Note: You may only view two cameras’ timelines at once, on the docked . To cycle between them click on the

icon at the bottom right of the timeline. If you wish to see more you may detach the timeline from the GUIL.
This is described below.
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e Detached Review Timeline

Timeline . | To detach the timeline from the
21/00 I\ GUI cI.|ck on the ““_H_.ICOH., at the

Highway 1 top right of the timeline. To

Spar l::\n = i reattach the timeline click, in the

W 3ting 10 —_—

Spar Queus same place, on the “=dicon.

Highway 2

Farctory

Highwway 3 ]

e Synchronised/Independent Review

By default all reviews are synchronised, when you have selected multiple cameras for review. It is possible to
review cameras independently.

When already reviewing a camera, if you middle click on a camera’s panel you Start new review group
will see the following options in the context menu. B Add to review

Start new review group will add this camera to a separate group of review cameras, which will be
asynchronous to the original review group. The new review group is indicated by the tag on the top-right of
the video. Each review group will get its own colour.

Add to review will add this camera to the already existing review group. As you add review groups the number
of options here will increase as a result.

e Timeline Actions

Zoom in on Timeline
There are two ways to zoom in on a section of the timeline.

1. By moussing over the timeline (during review) and rolling the mouse-wheel forwards. To zoom out roll
it backwards.
2. But shift-selecting a section of the time line.
* This is done by holding down the SHIFT key, while click-dragging your selection with the
left mouse button. Your selection will look like the image to the left.
To zoom in on this selection click on the “Zicon.

Move the Timeline with the Mouse

You may move backwards and forwards in time, by left-click dragging the timeline in the direction that you
want to travel.
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d. Panel Selector

[ Clicking on the drop down menu of the Panel Selector will
= Resources - |

. sl show you three options. The PTZ Controls, Contacts, and
@ PTZ Resources. The Contacts are special site contacts, setup by
& Contacts your administrator. The Resources are the site resources, such

as Cameras, Relays etc.

= Resources

Select Cameras from the Resources Panel

The resources panel will the one from which you select which cameras you want to view in the Cameras Panel.
There are a few ways to do this.

e Double-click a camera in the Resources panel

é""a"[:amems Double-click a camera in the Resources panel to load it Live
g -0 @is 1.3mp into the camera panel that currently has focus (is selected).

e Drag a camera from the Resources panel

‘ @all Cameras Left Click on a camera, holding down the mouse button, and

Drag a camera from the Resources panel (first drag the

= y— camera horizontally left, and then to the panel that you want
to view it in)

e Drag a group of cameras from the Resources panel

E----@all Cameras From release 5042c2, January 2011, you can select a group of
' cameras from the resource pane and drag them onto the
camera display (for camera tab or multisite tab). This is a
quick and convenient way to populate a screen with cameras.

This is achieved by selecting cameras while holding down the
CTRL button on your keyboard, then Dragging them across.

Mouse Over Options

When you hover your mouse over the Resources Panel you will see the following option set appear:

Be 7 8Y

e Lock Display

Lock display. Some CathexisVision events will be setup to switch the camera panel to view cameras related to

the event. Clicking on this lock will enable/disable this feature. An unlocked display (Ii‘l) will switch; a locked
display won't.

Draft Rev 1.2 November 25, 2014 Page 13



e PTZ Controls '@

To bring up the PTZ panel, click on the & icon in the Mouse Hover Options, in the Resources Panel. (Note:
Selecting the PTZ option from the Resource Panel dropdown menu will give you more PTZ options.)

With a Pan-Tilt-Zoom (PTZ) camera an operato

and amount of light. A PTZ camera is indicated i
pre-configured camera views called “Presets”.

B0 7 8Y

EED [Presetor 6o
Wanal

PTZ Panel

r can manipulate the camera's direction, zoom, focal distance

n the Resources panel with an e icon. He/she can also control

This panel provides controls for camera presets, and a
software joystick for interactive control of the camera.

The Preset controls enable you to set Presets and go to
Presets.

The curved grey buttons surrounding the joystick enable
zooming in and out, focussing closer or further away, and iris
control — lightening or darkening the camera image.

The Manual button is for manual override of the dome (to
override automated patterns, local tours etc.). The Auto
button relinquishes manual control, to let the system regain its
automated configuration.

Note the green text on one of these buttons. This indicates
which mode currently applies — - or - In the
example at left, the system can function automatically. The
screen may change unexpectedly as it runs patterns, tours, etc.

To pan left/ right from the PTZ panel
*) (5% Dragjoystick left / right

To tilt up / down from the PTZ panel

d) @ Drag joystick up / down

To move the camera faster from the PTZ
panel

Ce» Distance determines speed - drag joystick
out, in required direction

To move the camera slower from the PTZ
panel

Cren Distance determines speed - drag joystick
closer in, in required direction

To zoom in / out from the PTZ panel

Watch the live camera as you press the Zoom +
and Zoom - button

To focus further / closer from the PTZ panel

Watch the live camera as you press the Focus + and
Focus - button
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To go to a preset from the PTZ panel

Select the preset from the dropdown, and then
click GO

> The camera view will change to the preset.

To set a preset from the PTZ panel
1. Select the preset from the dropdown,

2. Use the joystick controls to establish the camera
view, zoom, focus and light (iris).

3. Click SET.
4. Go to this preset to check it.

To relinquish manual control of the dome /
PTZ camera from the PTZ panel
Click Auto. > If your system runs remote tours

automatically, or switches display based on events,
these automated responses will take over.

Pause a PTZ Tour

PTZ tours can be paused/restarted, per camera. This
is achieved by right-clicking on the camera in the
resource panel and selecting the "Pause/restart PTZ
tours" option.

To lighten/darken the live camera view from
the PTZ panel

Watch the live camera as you press the iris+, or iris
— button. You will see the image lighten or darken

To gain manual control of the dome / PTZ
camera from the PTZ panel

(This applies if you system runs remote tours
automatically, or switches display based on events)

Either click manual, or simply move the software
joystick

Individual Camera Panel Zoom Options

Note: If the camera supports any of the above then you can switch between digital and PTZ m
control using the icons on the bottom-left of the camera panel.

Zoom In/Out

Scroll the mouse wheel. Holding down the shift key
while scrolling the mouse wheel will do an
accelerated zoom

Zoom to Area

Holding the shift key select an area using the left
mouse button

Zoom out completely

Press the Z key or; hold the left mouse-button
down, for half a second, and select the zoom out
menu option

Center on Point
Holding the shift key press the left mouse button; or

Hold the left mouse-button down, for half a second,
and select the center on point menu option.

e Event Notifications ﬁ

If your administrator has set up Event Notifications for this unit then you will receive notifications based on

these setups.
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£ Notifications =
&, Camera: Highway 1 now g E il
1 A Message Notification
HEdge: Record Axis
17/h39 at Matthew's Site  (now)

2 A Popup Notification

=

An audio notification. This is a sound clip that gets
played when the event triggers.

A message notification. This is a message that gets
displayed in the notification area of the resource panel.
It's meant as an unobtrusive feed of events (To show the

L

notifications area, click the 3} icon at the bottom of the
resource panel. This can be resized). If an event has
camera resources associated with it then the notification
can be double-clicked and the cameras will be shown in
the camera view.

A popup notification. This is a popup message box that is
shown when the event triggers.

Clicking on the database icon in the notifications pane, will open that camera in the cameras panel at the

point, in the database, where the event occurred.
Clicking on the recycle icon will either clear the notification (if you click on the recycle icon attached to
the notification); or clear all notifications (if you click on the one at the top of the Notifications pane).

e Configure Resource Panel

This section allows the administrator to setup the various resources that are pulled through into the resources
panel. These include the Unit Resources, Camera Layouts, Camera Sequences, Layout Salvos, and Site Actions.

Note: Since this is part of the Site Configuration it has been dealt with in the full Setup Manual, for further
information refer to this manual.

—

|

e Resource Panel Filter A

———
Filter

B

LX)

(#® Audioln
Wi AudicOut

= Camera

[={camera layouts
&F Camera sequences
ESCentralStorageDb
+7Event

8 IntegrationDevice
FLayout salvos
ZEMetalb

[ Monitor
-.!E'!_.-Optolnput
(mRelayOut
ERing

(_)site actions

Clicking on the resource filter icon will bring up the
filter options.

The checked items will appear in the resources
panel; the unchecked items L will not appear.

This is useful in sites that have many resources that
the user may want to filter when looking for
something specific.

Ok

] [ Cancel
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Archiving is a facility to enable you to select recordings and copy them to archiving media, such as USB key,
hard drive or CD/DVD (note that for CD/DVD archiving the user must have Nero 7, or 9, installed on the
archiving computer). Unlike normal recordings, archived recordings retain their authenticity, and can be
verified as authentic (unaltered) on replay, making them suitable for use in courts of law.

Archiving is done from within the Cameras tab; reviewing an archive, and exporting AVI from an archive, all
occurs in the Archive tab, or the CatPlayer. This is why this section is separate to the Cameras Tab section.

a. Create an Archive

Local disk x|

Archive location | \archives D

Total archive size |4 MB

Progress

[7] Copy catPlayer

|Waiting for user to start archive |

Cancel ][ Mext = ]

b. Review an Archive

In selection that you made, above, simply click on the

lij icon. The dialogue to the left will appear.

Select the destination by clicking on D

Copy catPlayer will copy add a copy of the catPlayer to
the archive location. (This is useful if you are going to be
reviewing this video on another computer, which does
not have CathexisVision installed on it.)

Click next to complete the archive. You will be able to

see the archive’s progress:
Progress

——— |

Once it has completed, click on Close.

There are two means of replaying archived recordings:

1. The catPlayer archive player. The shortcut for which would have appeared on your desktop, at
installation; but may be found in the CathexisVision installation folder.
2. The Archive Player desktop in CathexisVision. The functionality is almost identical.

e Archive Viewer desktop in CathexisVision

File Edit View Archive

Open site ]
‘1_5_';5 Enterprise manager

= Archive viewer

Virtual NVR b
€ Quit

The Archive Player is incorporated as an “Archive viewer” desktop within
CathexisVision software.
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Archive Viewer Interface

Interface

Menu Options in Menu Options in
catPlayer catSite Archive player

Archive Tools Settings

[ Select directory [] Select directory
ﬁ Open local backup ﬁﬁ Open local backup

Quit

CatPlayer tab (in catSite this will be one of many tabs)
Archives Menu (to open archives)

Current Control Panel

(] catSite (1)

File Edit View Archive Tools Settings Help

Event List (=]
Middle Mouse Button Evertt Listing |
Pop-Up Menu
13 @ Standard Thumbnad
stai -
airs Recording
Maintain aspect ratio = 2012/05/24 14:25:31
v Deinterlace
Show debug STT
v  Fastest scaling = :
E 2 2012/05/25 14:48:55
v Rectangular transform
Spherical transform B @ 13
Cylindrical transform 2012/05/25 14:48:55
®13

[v Show time

No camera

Archive Data can be
viewed

FH” B i ' El=l=1=] ® -

=

(M[djajnjw]r[n[@)

CICIEAL

oo 0 0o k(.

Browse for Archives—
Open Local Backup =

Print Selected Frame =
Save Selected Frame —
Verify as Authentic ——

Player Controls

~ Go to first recorded frame
— Play backwards

—Step backwards

Pause

Step forwards
Play forwards
Go to last recorded frame
Go to Time
Tagged area of primary timeline

Replay speed control
I- Primary timeline

MlesJajuw[en3) i [ — | |

4 G0, 13/09/2005 09:57-18 @ 18/03/2005 111323 0 @ W

% o -3
I_ L Start tag dateftime End tag dateftime -l J J

View start frame View end frame
— Start tag Tagged area of primary timeline End tag
Clear tags

Archive tagged content

Using the Archive Player

There are a number of useful procedures to know, when it comes to using the Archive Player.

e To Browse for Archived Data in a Folder of Archives

There are three options here:
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Click the Archive > Select Directory icon to specify a M

folder of archives (on hard drive, CD/DVD or USB), or Lookin: [23V[+] 4 & = EE =

. fonis
|/ icons

(&8 =1 i Click the Browse for archives button, or ¥ shaders

_ ‘ES_J!‘ Click the Open local backup icon to locate a local

backup drive Directory:
File type: | Directon Cancel
e Select a Archive Recordings Viewing Type
= Event List .} Cameras List displays all cameras found in the archive folder. Drag cameras

to the desktop for camera replay.
@ Standard =) Thumbnail . . . ot .
Thumbnail Event List displays 1™ frame of each recording

L?"wwmmz:zms Standard Event List sorts Events by date/time

| oo ) Fighway 3
| @ Hotmay
E_.N;’lﬂmﬂ 00:19:04

=

BJSpar Overview
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e To replay a recording in a floating window

From the Event List (standard) panel, double-click an individual event item / recording, or
From the Event List (thumbnails) panel, double-click a thumbnail.

The replay window can display in two different forms:

uin| \View sequential images (as above)

Example: sequential images...

wanr| \/iew as 4 staggered panes

2012/05/24 14:25:31.328 (= 2012/05/24 14:25:31.368

(WA [y M@

[ 2012/05/24 14:25:11 448

e To display archived data in the Archive Player / Viewer desktop

From the Cameras panel, drag cameras to the desktop, or double-click a
camera to display it in the currently selected camera view, or

or double-click

From the Event List (standard) panel, drag individual event items
(recordings) to the desktop, or

From the Event List (thumbnails) panel, drag thumbnails to the desktop,
or

edlmieiad ui

Camera 02

mera 03

Middle-click a camera panel and then select the camera from the
middle-click menu.

e To Apply a Lens Transformation

i v Rectangular transform
Spherical transform
Cylindrical transform

Right-click the image and select one of the available “transforms”:

(For specific cameras that use very high resolutions and special lenses to enable the camera to cover
an entire room without panning. However, the lens twists the image, so when a user “pans and zooms” the
room during replay (actually pans and zooms the image), software is required to correct the image twist.)
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e To Locate a Specific Time in the Recording Timeline

{2y
Click the Time icon -, and then specify the time, using the
Date/Time dialogue. Or:

= qwmasmsigogiz . Drag the slider along the timeline until you reach the appropriate date/time. As you

drag, a “callout” displays date/time.

e To Verify an Event as Authentic

D select a specific Event (not a generalised camera review), and then Click the Verify

Event i
Time: 2012/05/24 14:25:31 Icon R
Camera: 64

Status:

Event verfied successfully

et A window displays, with verification or non-verification information:

OK

Note: This does not function with a camera review — you must select a specific event from the event list or
from a camera display of a specific event.

c. Exportto AVI

This will export that archived footage selected in an AVI format.

Via the Event List

1. Open the Event List as follows:
= Cameras (]
[&| Cameras
5] Even List_|
|@.1_3

2. Right-click the event and choose the export option that you require from the drop down menu.
= Event List ]

Event Listing

@ Standard () Thumbnail

Recording

B 5012/05/24 182531

E Archive Information

=] 20120 Export to AVL..

_ Export to Archive...
® Archive to CD/DVD...
2012/05/25 144555

13

=]

> This will open a file browser:
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I = Save As

Lookin: [ (=4 C/dvs/ =] & & ek
j .. . firmware . layouts_4ir . streamhistory
| Irdparty . forts . New Folder 1 . tmp
| Archive of Switch Theft . gnupg . New Folder 2 . translations
| Archives General . help . profdata . viewer
J bin . htmldoc . report_images . work
| buffer . icons . seftings
s cslr . icons_4Ir . shaders
| cygwin Jicons_gui | siteconfig
| dumps - keys . stedb
| files . layouts . sounds

Filetype: | AVI Video ("avi) [=] Cancel

3. Browse for a folder and click the “Save” button.
> The conversion (from the standard archiving format to AVI) will start, and will indicate when exporting is
completed:

!

<7 Export complete.

) Exporting video data . Encoding video data... (31%)

By Means of a Tagged Region

1. Tag a specific selection by using the toolbar at the bottom of the archive player:
Export zone to AVI

Clear tags

Pin/tag ending point
Pin/tag starting point in/tag ending poin

Time line Preview last frame
Preview first frame

0@ 19/02/2009 15:27:18 @ 1940242003 15:27:23 ':00

2. With the region successfully tagged, click the Export zone to AVI button.

3. Save the file to a folder and click the “Save” button:

| save ss ]
Lookin: |y C/dvs/ [=] & ck 62
.. . firmware . layouts_4Ir . streamhistory I
) drdparty . fonts . New Folder 1 . tmp
| Archive of Switch Theft . gnupg . New Folder 2 . translations
| Archives General . help . profdata . viewer
J bin . htmldoc . report_images . work
J buffer . icons . settings
s cslr . icons_4Ir . shaders
. cygwin . icons_gui . steconfig
| dumps . keys . sitedb
| files . layouts . sounds
Fietype: | AVI Video (2vi) [=]

The conversion (from the standard archiving format to AVI) will start and will indicate when exporting is
completed:

- Exporting video data Encoding video data... (31%) ¢ Export complete
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4 Layouts and Sequences (Video Wall Menu)

a. Video Wall

Videowall Tools Settings Help In pre-5403b software this menu was titled the Layout Menu,
and only contained setup information for Layouts.

: @ Recall layout »
& Create new layout... A Layout defines how the cameras appear on the screen, in the
& Overwrite layout 4 Cameras Tab. Including which cameras are shown, and how
Resize layout... much space they take up on the screen.

El Manage layouts... . L .

A Sequence is a cycle of individual cameras that will run, on a
& Recall sequence b timer, in a single viewing pane, in the Cameras Tab.
&5 Manage sequences... . . . . . .
' The Switch Display Settings for this tab will define the
Switch display settings for this tab... behaviour of the currently open Cameras Tab, when video
information is sent to the Client Station with an alarm.

Note: this menu option will only be present when you are viewing a Cameras Tab.

Layout

A Layout defines how the cameras appear on the screen, in the Cameras Tab. Including which cameras are
shown, and how much space they take up on the screen.

e (reate new Layout

To create a layout, organise your cameras on the screen as you desire (double-left-click to expand; single-right-
click to reduce). Then click on —>New. Give the Layout a name, and click OK. (you can use Layouts
created in the Cameras Tab in the Monitors Tab, and Visa Versa.)

e Recall a Layout

]

To bring up a list of existing Layouts, click on g Recall and select the layout name that you desire.

e Overwrite Layout

Clicking on [ Overwrite  » , and selecting on one of the Layouts in the list, will overwrite that Layout with
the current panel organisation.

e Manage Layouts

Clicking on G Manage | bring up the list of existing
Layouts for you to manage.

From the management list you may either delete the Layout
or enter the Layout Properties window.

These are both done by right-clicking on the Layout in the

list.
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Pro

Name |50

User D

Access rights

In the Layout Properties window you may change the
Name, and User ID of the Layout, as well as the User Access
Level required to view, or edit, the layout.

Note: if you have limited access rights, you won’t be able to

e Resize Layout

Height 4

Alr

Sequence

| [ Levell [7] Level2 [7] Level 3

change these settings.

Clicking on Pesizelayout.. i oive vou the ability to change how many

cameras are arranged on the screen.
You may define how many cameras there are per row, and per column.
The maximum amount of cameras you may have per screen will be an 8*8

matrix. This gives you a possible 64 cameras per Layout. (This would
require an incredibly large screen to be practical though.)

A Sequence is a cycle of individual cameras that will run, on a timer, in a single viewing pane.

e Sequence Manager

E;.- Salvo Manager

28 2 cameras and Just Axis

9 =)
. Clicking on the icon will bring up the

Sequence Manager.
To edit a Sequence, select the existing
Sequence and click Edit. To create a new

Sequence click on New. This will bring up

Edit ] ’ Ok the Sequence Editor.

e Sequence Editor

You may access the Sequence Ed

itor, where you can create and edit sequences, via the Sequence Manager.

i A58 Nare your Sequence appropratey

Name || Should lecp
The left hand panel will hold a list of
Camera Duration Dome command .
available cameras.
The right hand panel will hold a list of
- cameras that are included in the
o] T BN Sequence.

Sequence Editor Procedures

Add a camera to a Sequence

You may:
-double-click on a camera in the list of available cameras.
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-Or click-drag one, or multiple cameras, across into the Sequence list.

Remove a camera

Right-click on the camera and select Delete.

Set the duration of a camera
for each loop of the
Sequence

-Right-click, and select Set Duration.
-Enter the duration in seconds, and click OK.

Looping

If the Shouldloop o ption is checked the Sequence will run indefinitely, if it is
unchecked the Sequence will run once.

Change the order

order.

Select a camera and use the arrows to move that camera up or down the

e Recall Sequence

To recall an existing sequence click on = FRecall sequence 4 1yins 5 3 list of all existing sequences. Click on
the sequence you wish to run.

Switch Display Settings

This will define how your cameras tab responds when there is an event on the site that sends video and
information to the Cameras Tab of the viewing client.

Note: The Switch Display Settings that you set here are for the currently open tab only

Switch display
Configure switch display settings for new tabs

[] Lock display

i) Don' restore display

[] Criy switch local cameras

i@ Restore display after | 3sec =

0K

|| cancel

Lock Display
Will prevent the Cameras Tab from displaying any video
feeds sent to it by the Event.

Restore display after
Will define how long after switching to the Event Cameras
the Cameras Tab will return to the original display settings.

Don’t restore display
Will leave the Cameras Tab on the Event Cameras until an
operator, or administrator, resets the display.

Only Switch Local Cameras
Will only switch to Event cameras originating from a local
site.

Note: you may also either Iocklil, or unlock |I"|, the currently opened Cameras Tab by clicking on the little lock
located at the end of the Timeline on the Review Controls.
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5 Database Tab

a. Database Tab

| & CathexisVision 2015 - 504

File Edit View Site Tools

& virwalvr | = virtual R

Settings

Help

D

Resource
=-® virtual 5043a (MASTER)

Databases

Event Time

F New event 2014/10/24 07:54:42
7 MNew event 2014/10/24 07:54:43
7 New event 2014/10/24 07:54:51
7 New event 2014/10/24 07:54:57
7 MNew event 2014/10/24 07:55:01
7 New event 2014/10/24 07:55:08

List of Database
Entries

7 New event 2014/10/24 07:55:23
7 MNew event 2014/10/24 07:55:35
7 New event 2014/10/24 07:55:51
7 MNew event 2014/10/24 07:56:04
7 MNew event 2014/10/24 07:56:04
7 New event 2014/10/24 07:56:08
7 New event 2014/10/24 07:56: 11
7 MNew event 2014/10/24 07:56:19
7 New event 2014/10/24 07:56:30
7 MNew event 2014/10/24 07:56:33

P @ @ @ []

Index Resource Type
Activity -
Spar QOverview VIDEQSTREA

P
(el -

e

CE: Details of Selected

Database Entry

Connected to unit Virtual 5043a

Unit Connected To

Supplied to Documentation by Cathexis Internal

& dvs (Administrator) @ CathexisVision Premium

To open the CathexisVision Database Tab select Site—>0Open Tab—
>Databases

Site Tools Settings Help

d (= Cameras

ﬁ% Close site's tabs
@ Change

= -

password...

b. Replay a Recording

To replay a recording that has been associated with a database entry, simply double click on the relevant
entry.

Replay as a Stepped Strip, or a Single Image.

You may play your replay as a strip that is stepped by four frames, this is useful for comparison between

([ 1]1]
frames, as you may have four sequential frames visible at all times. Click on ﬂ for stepped replay, and click

on ﬂ for single pane replay.

In both instances the date and time of the current frame will be listed in the grey bar under the frame.
| 2013406711 14:31:46.3595
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e Playback Controls

Go To First Recorded Frame
Rewind

Step Backwards One Fram
r Playback

|_P‘""”Se Speed
K 1) e

|—Se|ect a Specific Time
Step Forward One Frame

Play Forward
Step Forwards One Frame

Do a Time Search

1. Inthe Database Tab, click on the icon, located in the bottom right hand corner.
2. Select the date and time:

. n . = - 0K
11 2| June [=](2013 [ 06 40 =|[49 *land c|,ck

The list of database entries will have been pared down to beginning with the event closest to the time you
selected, and a few subsequent entries.

d. Filter a Database to Locate Recordings

While the time-filtering is useful, CathexisVision provides for far more powerful filtering of databases. There
are three major filter types: Filters, Field Constraints, and Time Constraints.

Note: All filtering is based on AND/OR options.

AND If you apply Filter A AND Filter B, the result will contain only those Events in which both Filter A and
Filter B are true.

OR If you apply Filter A OR Filter B, the result will contain any Event in which Filter A is true, plus any Event
in which Filter B is true.

Note however that within a single filter you cannot use both functions — so you cannot apply “Filter A AND
Filter B OR Filter C”. (It must either be all AND filters or all OR filters.)

e Add/Remove a Filter

Click on % to add a filter.
Click on g to remove a filter.

e FEnable a Filter

o e In order to have any of the Filters active you need to check the

relevant filter box at the bottom of the filters dialogue.
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Note: you may further constrain results, by making Filters and Field Constraints AND/OR dependant. For

example you may have a search that requires that the Eventmustmatchfiters gr field constraints o vy may have
it set so that the Event must match fiters g’ field constraints

Filters Tab

If event These are the primary sorting lists. The blue underlined style indicates that they are options.
has camera | Click to see a pop-up list of the options. You can choose from the following:

Cameran Has camera > (then choose camera from Camera Name dropdown list)
Has audio > (then choose audio input from Audio Input Name dropdown list)
Is tagged

This is a logical parameter for multiple filters. It may be “and” or “or”. It only appears if you
have more than one filter. By default it is “and”.

The filter results must match all of the filters. For example, if we have
% f event & fsoged and

g ff event fizs camers  Caf Tech Siding Zone 788 and

)
>
o

g f event fas aud O Teoh Sidng Fone 748)

and Then the result is only those Events that are Tagged, that also include Camera 5
- content, and that also include Audio Input 3 content — probably a short list.

The filter results must match any of the filters. For example, if we have
= ; I event hzs camem O Tech Siding Fone 788 or

%Heuerﬂ Ef ar
or

% Fevent fas audic O Tech Shding (Fone 748)

Then the result is all events with Camera 5 content plus all Events that are tagged
plus all events that have Audio Input 3 content — probably a long list.

Field Constraints Tab

This tab is only visible if you have a streaming text data application installed, in which case you see these text
data field filters. They include the fields that have been identified in the text data streaming setup. i.e. on this
tab you will see the fields that you have customised for the text data application.

Examples of text data are the data streamed from till transactions (transaction number, purchase amount,
time, number of purchased items, etc.), and data streamed from Access Control applications (name, time,
employee number, etc.). This data is stored as different “fields”. It is possible to constrain filtered results based
on various decisions with these fields.

The principle remains the same as the Filters tab, where you create a filter and then change its parameters
using dropdown options (see above). The nature of these parameters depends entirely on your custom
application.
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Time Constraint Tab

There are a number of different ways to constrain the time these are:

equal to

greater than

greater than or equal to
less than

less than or equal to
between (inclusive)

between (exclusive)

Note: to modify the times click on the Date/Time hyperlink and enter in your parameters in the dialogue that
pops up.

e. Archive Selected Database Recordings

If you wish to save a particular Database entry for later viewing, or to prevent an important piece of

=i
information from being overwritten, you may archive it. To archive a selected Database Entry click on the
icon.

7 Archive H_ e L2 |WES8  The archive interface will tell

you where the archive will be

created, and allow you to define

Archive location | C:\Program Files {<86)\Cathexds catVision Suite WRV\archivesJohnny's Power Supply @ your own archive location.

Total archive size [2 MB |

You will also see the total

Frogress archive size that the Archive will
take.
[ Copy catPlayer The progress bar will indicate
|Wa'rtingforuserto start archive | how far anng the archives
creation is.
Cancel ] [ Neod = ]

The [] Cepy catPlayer option exists because the archived recording, for authenticity purposes may only be
played back using CathexisVision’s archive player (which comes with all installations of the CathexisVision
suite). If you are going to be playing the archive on a computer that does not have the CathexisVision suite,
you may check this option, and an archive player will be included in the archive’s folder.

o Archive Multiple Database Entries

To archive multiple Database entries simply Ctrl-Click, or Shift-Click, the entries that you wish to archive, and
follow the procedure outlined above.

f. Print an Image from a Video Replay

To print a specific frame from video replay, you may right click anywhere on the on the image, and select print.
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6 Monitors Tab

The monitors tab is a tab that gives you full control over the Video Wall. Here you can change the layout, and
define camera Sequences, and salvos.

You will not see any video playing on the interface. You will see the names of cameras where they are placed
in the layout.

Moritors  |[] Matthew's Sie 3¢ |§§ Matthew's Ste 3¢ —

7 Matthew's Site #]

- @ass
@, Doorway
woidsf

0 Mo camera

e Mo camera

e Mo camera Q Mo camera

B EE DB

'3 Dioorw oy

0 Mo camera Q Mo camera

Wafafnjw|v[M[O) o &

Open a Site on a Screen

The list of monitors that you see will be representative of the number of monitors that have been added to
servers on the site.

To Open a monitor from a site, select one of the available
Monitors. Then click the Sites list:

o Matthew's Ste B

Second Mondlor

Matthew's Sae

Then select your site.
The Monitor with a red border will be the Monitor whose camera Layout is displayed below it.

Layout

A layout defines how the cameras appear on the screen. This includes which cameras are present, to how
much of the screen an individual camera takes up.

Recall a Layout
To bring up a particular layout on a screen, click on the icon, and select the layout name that you
desire. The Layout
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Sequence

A Sequence will run a set of cameras, in single camera panel.

Run a Sequence - Click on a camera panel.

- Click on

- Select the relevent Sequence from the drop down menu.

Salvo

A Salvo is a set of Layouts. This means that the Layout of cameras on the monitor will change, running through
a set order, using the pre-defined Layouts.

Run a Salvo - Click on a Layout panel.

- Click on

- Select the relevent Salvo from the drop down menu.

Virtual Cameras interface

The virtual cameras interface is the
interface where you

Q Mo camera Q Mo camera

e See the Layout that the cameras
will take on the Monitor that you
have selected.

@ Nocamers @ Mo camers e See what cameras are in which
panels.

e May control the overlays on
each camera

e And use the Playback controls to
review video on the Monitor.

'e' Mo camera 'e' Mo camera

)
L

Doorway

'e' Mo camera 'e' Mo camera

M laln > M[E) =] %

e Individual Panel Settings

To change the settings of an individual panel middle-click on the panel, this will bring up the following menu:

Set no camera Set No Camera will make this panel blank

Review camera This will bring up the recordings of the selected camera. For information on reviewing the
camera see the section below, on Review Controls

Mext video format | This will cycle through the available video feeds that are available on the selected camera.
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e Review Controls

~ Go to first recorded frame
- Play backwards
~Step backwards

~ Pause

- Step forwards
Play forwards

Go to last recorded frame
Go to Time
Replay speed control

[ I—Go Live

MdJajufn[»[n[®) g &

Draft Rev 1.2

Note: When a camera has been selected
border, and camera name, will become Green:
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Doorway
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7 Audio procedures

m A microphone and speaker on the menu bar (at the top right of the screen) represent your two
local audio hardware resources, local audio input and local audio output.

These two icons represent the state of your local microphone and speaker - when a resource is being used, its
icon is bright - in colour, and when the resource is inactive, and its icon is grey.

You can look at these icons to see the current state of audio interaction, and you can run your mouse cursor
over a - icon for information on the activity. However, the actual control of audio is from icons in the
Resource Panel and Live remote cameras:

e To Listen to a Remote Site by Means of the Resource Panel

Open the Resource panel for the remote site, and double-click the remote microphone that you wish to listen
to. Your local speaker goes green, indicating that your listening is in progress. If you move the cursor over the
speaker, you will see a tool-tip describing the remote audio input that is being listened to. You should hear
sound from the remote site.

e To Stop Listening to a Remote Site by Means of the Resource Panel

Right click your local speaker, and choose Stop.

Your local speaker goes grey, indicating that your listening is no longer in progress.

e To Listen to Remote Live MPEG by Means of the Middle-click Camera Menu

A Live remote MPEG camera with audio will display a small
microphone icon before the name on the camera display:

Middle-click the camera image, and select Listen from the menu.

You will see the icon change from grey to green, to indicate activity. You should also hear sound on your local
speaker

e To Stop Listening to Remote Live MPEG by Means of the Middle-click Camera Menu

Middle-click the camera image, and select Stop listening from the menu.

You will see the icon change from green to grey, to indicate inactivity. Sound should stop on your local speaker
e To Speak to a Remote Site

Open the Resource panel for the remote site, and double-click the remote speaker that you wish to speak
through.

Your local microphone goes green, indicating that your speaking is in progress.
e To Stop Speaking to a Remote Site

Right click your local microphone, and choose Stop call.
Your local microphone goes grey, indicating that your speaking is no longer in progress.

Draft Rev 1.2 November 25, 2014 Page 33



8 Other procedures

e To Switch a Relay Output (e.g. unlock a door, activate a siren)

Relay outputs can also be switched from the Map (right-click>Set Output / Clear Output).

The action performed when double-clicking a relay in the CathexisVision resource panel is configurable. The
setting is in CathexisVision menu->Settings->General

1. ':!E:' Left double-click to toggle the relay between set and clear, or

Right-click the relay.

> A popup menu offers you the choice of Set output (activate it) or Pulse Output.
2. Select an option and click OK.

>The relay changes state, and the output changes colour O While active the play pause image in the middle
of the Output icon will change from black to white.

3. To clear a set relay, left double-click or right-click >Clear output

e To Pulse a Relay Output (e.g. unlock a door for a defined 4-second period)
Relay outputs can also be pulsed from the Map (right-click>Pulse Output).

e
b Right-click the output and select Pulse output.

> This pulses the output for the time that has been set at the unit. While the output is pulsed the play pause
image in the middle of the Output icon will change from black to white, when it resets it will return to black.

e To Manually Trigger a Site Action

. Output Pulse - Right-click the Site Action in the Resources Pane and

= =vie 1 Tmin then click Execute.

Note: This requires 1) Site action setup 2) Assignment of site action to resources pane 3) Appropriate access
rights.
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